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Marblesoft makes no warranties, either expressly or implied, regarding the software 
described in this manual and its suitability to a particular purpose.

In no event shall Marblesoft be liable to anyone for special collateral, incidental or 
consequential damages in connection with or arising from the purchase or use of these 
programs.  Marblesoft shall not be liable for any claim against the user of these programs by 
any other party.  Marblesoft’s liability shall in no event exceed the price actually paid by the 
customer for the use of the software.

Marblesoft does warrant for one year after purchase of Early Learning I by the customer, 
the software shall reasonably conform to the standards defined in this manual.  Marblesoft 
specifically does not warrant that the software will operate uninterrupted or error-free.  
The sole and exclusive remedy for a failure of the software to perform in accordance with 
the accompanying documentation is for the customer to return the software to Marblesoft 
and to notify Marblesoft in writing of the nonperformance within one year of purchase.  
Marblesoft’s sole obligation shall be to provide the customer with a performing copy of the 
software within a reasonable time after receiving notification of nonperformance.

Marblesoft reserves the right to make improvements to Early Learning I at any time and 
without notice.  Marblesoft reserves the right to provide software upgrades at a reasonable 
fee.  By accepting an upgrade, the customer agrees to destroy all prior copies of the software 
and documentation.  The terms and conditions of this agreement apply to any and all 
upgrades.

Warranty Disclaimer
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This manual and the Early Learning I programs are copyrighted.  Any reproduction, in 
whole or in part, of this manual or the Early Learning I software is prohibited by federal 
copyright laws, including unauthorized electronic reproduction of the Early Learning I CD.  
The copyright laws provide for criminal penalties of up to one year imprisonment and/or a 
$10,000 fine.

This product is sold for use on a single computer at a single location.  Contact Marblesoft for 
information regarding site licensing.
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Introduction
Welcome to Early Learning I, an educational program for use on Macintosh and Windows 
computers.  The program is geared toward pre-school, early elementary and special 
education students.  The skills the students learn are taught with a minimum amount of time 
on the part of the teacher or parent.

Sight and sound help the student learn.  Because each student has individual needs, we’ve 
designed these programs with the flexibility to allow the teacher or parent to tailor the 
lessons to the particular needs of the student.

The program is patient.  It prompts for a response, waits for an answer and then praises the 
student for good work.

However, Early Learning I is not a video game.  While it is intended to make learning fun, its 
purpose is not entertainment.  

The graphics are clear and simple.  The student is not rewarded with explosions and flashing 
lights, but rather with a good word from a friendly voice.  The problems addressed by the 
program have been selected by experienced elementary and special education teachers.  

We hope you’ll find Early Learning I a useful teaching aid.  We also hope the use of the 
program will be a rewarding experience for your students and children.

Note:  When the term “Early Learning” is used in this manual, it refers to Early Learning I or 
any other Early Learning programs by Marblesoft.
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System Requirements
Early Learning I requires at least the following minimum system:

Macintosh 

• 64 MB RAM
• 13” color monitor
• CD-ROM drive
• MacOS 9.0.4 or later (runs natively on OS X as well).

In addition, Marblesoft recommends the following:

• 17” color monitor
• 32-bit color (“Millions” of colors)

To determine your 
system configuration, in 
MacOS 9, choose “About 
this Computer” from the 
Finder’s Apple menu.  
A window something 
like the one on the right 
appears:

In this example, we can 
see that we have 640 MB 
RAM, a 280 MB block 
free for the application, 
and MacOS 9.2.  
 
In OS X, choose “About this Mac” from the Apple 
menu.  In this example, we can see that we have 512K 
of RAM and Mac OS 10.4.2.
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Windows 

• 64 MB RAM
• 13” color monitor
• CD-ROM drive
• Windows 98 or later.

In addition, Marblesoft recommends the following:

• 17” color monitor
• 16-bit color (“High” color)

To determine your system configuration 
on Windows 98, right-click on “My 
Computer” on the Windows desktop and 
select “Properties” from the contextual 
menu.  You’ll see a window something like 
this one:

In this example, we can see that we have 
128 MB RAM and Windows 98.

On Windows XP, choose “My Computer” 
from the Start menu.  Click “View System 
Information” to bring up the System 
Properties window.  Click the “General” 
tab.

In this example, we can see that we have 
512 MB RAM and Windows XP.
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Most educational programs display an image of a fixed size, typically 640 x 480 pixels, 
no matter what size monitor the program is running on.  On large monitors, the program 
“letterboxes” the image, filling the unused portion of the screen with black.

In order to provide the sharpest possible image for your students, Early Learning I is 
optimized to fill all monitors up to 1280 x 960 pixels.  That not only means a larger image 
for the student to see, but more pixels, creating a sharper image.  In fact, with Early Learning 
I running on a 1280 x 960 monitor, you get 4 times as many pixels as a typical program 
displaying just 640 x 480 pixels.

To get the best possible image, set your monitor to the highest possible resolution that will 
display 32-bit color, up to 1280 x 960.  Early Learning I will automatically fill the screen with 
the sharpest possible image.  This is particularly important on Windows computers, where 
graphics can look rough and jagged when scaled down to fit small monitors.

Macintosh

From the Apple menu, select the Control Panels submenu and choose the “Monitors” control 
panel.  A window something like this one will appear:

Select the highest resolution on the right that allows “Thousands” (16-bit) or “Millions” 
(32-bit) of colors on the left.  In this case, you can see we have selected 800 x 600 pixels and 
thousands of colors.

About Colors and Monitor Size
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Windows

From the Start menu, select the Settings submenu and choose “Control Panel”.  From inside 
the control panel, double-click on “Display”.  The system will bring up a window something 
like this one:

Click on the “Settings” tab.  Select the highest 
resolution that still allows “Highest (32 bit)” color.  
In this case you can see we have chosen 1152 x 864 
pixels and Highest Color.

Windows XP users:
While Early Learning I works in 16-bit color on 
Windows XP, it looks much better in 32 bit color.  
Don’t use 16 bit color on Windows XP unless your 
monitor will not display 32 bit color.
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Installing Early Learning I

Macintosh

Before installing or running Early Learning I, read the “Read Me First” file on the CD for 
any changes that were made after this manual was finished.  Place the disk into a drive and 
double-click on the “Read Me First” icon. 

To install the software on your hard drive, double-click on the “Early Learning I Installer” 
icon.  After the splash screen, and the “Read Me First” window, a dialog something like this 
one will appear (MacOS X version shown here):

The installer should automatically open to the “Applications” folder on your hard drive.  You 
can switch to any other folder, but we suggest using the default Applications folder.  Click 
“Choose” to begin installation.

While Early Learning I is being extracted, the 
information displays the installer’s progress 
something like this:  

Finally, when installation is complete, another 
dialog appears.  Click the “Quit” button to finish.

The Early Learning I installer creates a folder named “Marblesoft” in the Applications folder, 
or whatever folder you specified.  The Early Learning I program is put in that folder.  You can 
move the Marblesoft folder anywhere you like, but it is recommended that you leave Early 
Learning I in the Marblesoft folder.  That way, the program and all your student score files can 
be easily found in a single location.  If you like, you can create an alias to Early Learning I and 
place it in any convenient location.
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Windows

The Early Learning I CD for Windows is an auto-run CD.  When you insert the CD into the 
drive, it should automatically run the installer.  If not, open “My Computer”, open the CD, 
and run the “setup.exe” program.

After a splash screen, you’ll see the “Read Me First” screen.  Please read this file for any 
changes that were made after this manual was finished.  A copy of the “Read Me First” file is 
also included on the CD, so you can read it in the future without having to run the installer.

After the “Read Me First” screen, you’ll see a dialog 
something like this one:

The installer will ask you where you want Early 
Learning I to be installed.  The default is to install 
it inside a folder named “Marblesoft” inside your 
Program Files folder.  In most cases, you should accept 
the default location.

Another screen will ask you where to put Early Learning 
I in your Start menu.  The default is to put it in a folder 
named “Marblesoft”.  Again, you should accept the 
default in most cases.

Finally, you’ll be given a chance to make a shortcut to 
the program on your desktop, and a chance to launch 
the program automatically once the installer is done.

While Early Learning I is being extracted, the 
information displays the installer’s progress something 
like the one shown here:  

Finally, when installation is complete, another dialog 
appears.  Click the “Finish” button to finish.

The Early Learning I installer creates a folder named 
“Marblesoft” at the specified location.  The Early 
Learning I program is put in that folder.  You can 
move the Marblesoft folder anywhere you like, but 
it is recommended that you leave Early Learning I in 
the Marblesoft folder.  That way, the program and all 
your student score files can be easily found in a single 
location.  If you like, you can create a shortcut to Early 
Learning I and place it in any convenient location.

IntelliKeys Overlays

A folder named “IntelliKeys Overlays” will be created inside the Marblesoft folder.  It 
contains the overlay files required to use Early Learning I with an IntelliKeys keyboard.  
You can print them out using your Overlay Printer application and can send them to the 
IntelliKeys keyboard with Overlay Sender.
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To start Early Learning I, double-click on its icon.  Press a key or click the mouse when the title 
screen appears to bring up the main menu.

The first time you run Early Learning I, the program creates a preferences file in your system 
folder or registry and creates a folder named “ Student Scores” in the same folder as the Early 
Learning I program.  This folder is the folder where you can keep your students’ scores from 
Early Learning I or any of Marblesoft’s other Early Learning programs.

Choosing an Activity

Early Learning I uses a simple on-screen menu to allow the student to select an activity.  The 
student can select one of the four activities with the mouse or by typing a key from “1” to 
“4”.  Alternately, the activities can be selected directly from the Activity menu. 

A Note About the Menu Bar

When  Early Learning I is run for the first time, the menu bar is hidden so the student can use 
the program in full-screen mode.  To show the menu bar and its contents, you can press (Mac 
⌘-F, Win Ctrl-F) at any time.

When you are through with an activity, simply select another activity from the Activity menu 
or press (Mac ⌘-W, Win Ctrl-W) to return to the main menu.  

Setting the Level of Difficulty

Each activity in Early Learning I has multiple levels of difficulty.  To change levels, pull down 
the Activity menu and select from these three choices:

“Advance a Level” (Mac ⌘-A, Win Ctrl-A) advances the program one level.

“Back a Level” (Mac ⌘-B, Win Ctrl-B) sends the program back one level.

“Go to Level...” (Mac ⌘-L, Win Ctrl-L) brings up a dialog asking you to select the level you 
want to run.  

Note

Unless noted otherwise, the following sections describe the activities while in the keyboard 
mode.  The activities in the other modes may be slightly different.

Running Early Learning I
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The Matching Colors activity familiarizes the student with up to twelve common colors.  The 
lower levels allow the student to see the colors displayed on the screen and to see the effects 
of selecting a color.  On the higher levels, the student is asked to match a specified color.  At 
first the specific color is shown alone, later the computer asks the student to pick it out from 
among several colors.

When a correct answer is given, the program displays the answer at the bottom of the screen.  
If a wrong answer is given, the answer is shown on screen, the student is corrected and given 
another chance to answer.  After a specified number of wrong answers is given (see Program 
Control - Rate of Advancement), the student is shown the correct answer and allowed to try 
again.

Matching Colors can be set to drill the student on any of 3 different sets of 4 colors each or 
a set of either 8 or 12 colors.  Additionally, color pictures can be substituted for the default 
colored blocks.  This variation is for the student who has mastered the basic colors and 
understands that, for example, an apple is red even if it has a green stem.

Levels of Difficulty

Level  1 Displays the colors in the range selected and pronounces their names.  
If the student selects the color displayed, that color is shown at the 
bottom of the screen and its name is spoken.  

 2 Allows the student to experiment with the colors displayed.  When the 
student selects a color, it is displayed at the bottom of the screen and 
the name of the color is spoken.

 3 Asks the student to match the color on the screen.  When using the 
mouse or TouchWindow, the student simply clicks on the displayed 
color.  Using a keyboard such as IntelliKeys, the student finds the 
specified color on an overlay.  In the Yes/No mode, different colors are 
flashed on screen for the student to choose.

Matching Colors

Level 1

Level 2 - after answer

Level 3 - custom pictures
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 4 Asks the student to pick out the color from among several different 
colors.  The student selects the correct color from the ones on the 
screen.

 

 

 5 Same as level 4 with the colors arranged in a random order.

Choosing the Colors

To select a different color set, select “Choose Colors...” (Mac ⌘-K, Win Ctrl-K) from the 
Activity menu.  A dialog box like the one below will appear (Mac OS 9 version shown here):

Select the color set you wish to use  by 
clicking on its radio button or by typing 
its letter.

The seven color sets from which to 
choose are:

A Red, blue, yellow, green

B Black, white, orange, gray

C Red through gray

D Purple, pink, brown, tan

E Red through tan

F Pictures representing red through gray
 
G Pictures representing red through tan

The color names checkbox determines whether the color name that is shown after a correct 
answer is shown in upper or lower case.

Level 4 - 8 custom pictures

Level 5 - 12 custom pictures
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The Learning Shapes program familiarizes the student with up to 12 common shapes.  The 
lower levels allow the student to see the shapes displayed on the screen and to see the effects 
of selecting one of them.  On the higher levels, the student is asked to match a specified 
shape.  At first the specific shape is shown alone, later the computer asks the student to pick 
it out from among several shapes.

When a correct answer is given, the program displays the answer at the bottom of the screen.  
If a wrong answer is given, the answer is shown on screen, the student is corrected and given 
another chance to answer.  After a specified number of wrong answers is given (see Program 
Control - Rate of Advancement), the student is shown the correct answer and allowed to try 
again.

Learning Shapes can be set to drill the student on any of 3 different sets of 4 shapes each or 
a set of either 8 or 12 shapes.  Additionally, color pictures can be substituted for the default 
shapes.  This variation is for the student who has mastered the basic shapes and understands 
that, for example, an orange can be recognized as a circle even though it is not perfectly 
round.  

Levels of Difficulty

Level  1 Displays the shapes in the range selected and pronounces their names.  
If the student selects the shape displayed, that shape is shown at the 
bottom of the screen and its name is spoken.  

 2 Allows the student to experiment with the shapes displayed.  When 
the student selects a shape, it is displayed at the bottom of the screen 
and the name of the shape is spoken.

 3 Asks the student to match the shape on the screen.  When using the 
mouse or TouchWindow, the student simply clicks on the displayed 
shape.  Using a keyboard such as IntelliKeys, the student finds the 
specified shape on an overlay.  In the Yes/No mode, different shapes 
are flashed on screen for the student to choose.  

Learning Shapes

Level 1

Level 2 - after answer

Level 3 - custom pictures
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 4 Asks the student to pick out the shape from among several different 
shapes.  The student selects the correct shape from the ones on the 
screen.

 

 

 5 Same as level 4 with the shapes arranged in a random order.

Choosing the Shapes

To select a different set of shapes, select “Choose Shapes...”(Mac ⌘-K, Win Ctrl-K) from the 
Activity menu.  A dialog box like the one below will come up (Mac OS 9 version shown here):

Select the shape set you wish to use by 
clicking on its radio button or by typing 
its letter.

The seven shape sets from which to 
choose are:

A Circle, square, rectangle, 
triangle

B Heart, star, diamond, oval

C Circle through oval

D Cross, arch, arrow, octagon

E Circle through octagon

F Pictures representing circle through oval
 
G Pictures representing circle through octagon

The shape names checkbox determines whether the shape name that is shown after a correct 
answer is shown in upper or lower case.

Level 4 - 8 custom pictures

Level 5 - 12 custom pictures
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The Counting Numbers program familiarizes the student with numbers from 0 to 20.  The 
lower levels display a number of icons and the number itself on the screen.  The computer 
counts the icons as they are displayed.  The student is asked to find the number.  As the 
difficulty level increases, the clues are gradually taken away until the student is counting 
with no help from the computer.

When a correct answer is given, the program displays the selected number at the bottom 
of the screen.  If a wrong answer is given, the answer is shown on screen, the student is 
corrected and given another chance to answer.  After a specified number of wrong answers is 
given (see Program Control - Rate of Advancement), the student is shown the correct answer 
and allowed to try again.

Counting Numbers can be set to use any range of numbers from 0 to 20.  The default is 1 
through 9.  See Choosing the Numbers on the next page to change the range of numbers to 
be practiced.

Levels of Difficulty

Level  1 Displays a number for the student to find.  The student types the number on 
the keyboard or clicks it on the screen.  This example shows the color picture 
icons.  The icons are drawn as large as possible (up to a practical limit) to fit 
the space on the screen.

 2 Same as level 1 with the numbers presented in random order.  Note in this 
example how the icons are slightly smaller in order to fit the space.

 3 Asks the student to find a number.  The student is not shown the number 
specifically, but identifies it as the last number in the counting sequence.  This 
example shows the high-visibility icons.

 

 4 Asks the student to find the number counted by recognizing the sound of the 
number as it is spoken.  Mouse and TouchWindow users use an on-screen 
number line (shown here) to answer.

Counting Numbers

Level 1

Level 2 - after answer

Level 4

Level 3
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 5 The student counts the objects independently without the aid of the voice.  
On this and all higher levels, the student is actually counting rather than just 
identifying a number.

 6 Presents the objects in several different configurations for the student to 
count, rather than always in a horizontal line.  The student has to determine 
the order in which to count.  Black and white icons shown here.

 7 Presents the objects in random arrangements on the screen, with the shapes 
aligned to a grid.  The student must mentally check off each object as it is 
counted.

 8 A totally random arrangement.  Some shapes may overlap each other up to 
50%..

Choosing the Numbers

To select a different series of numbers, select “Choose Numbers...” (Mac ⌘-K, Win Ctrl-K) 
from the Activity menu.  A dialog box like this one will appear (Mac OS X version shown 
here):

The number range is the range of problems that will 
be given to the student.  The default is 1 through 9.

The “Icons” buttons allow you to select which type 
of icons are presented for the student to count on 
screen.  There are two types of icons used:

• Color Pictures - Small color pictures of 
various recognizable objects. 

• High Visibility - Simple, colorized shapes which are easier for the student to see 
and count.

• Black and White - Black and white versions of the high visibility icons.

Level 5

Level 6

Level 8

Level 7
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The Letter Match program familiarizes the student with upper and lower case letters from 
A to Z.  

The program displays a letter on screen for the student to find on the keyboard.  Students 
using a mouse or TouchWindow simply click on the letter on the screen.  As the program 
progresses, the student has to pick out the correct answer from more and more choices.

When a correct answer is given, the program displays the selected letter in the middle of 
the screen with an outline around the two matching letters.  If the “Reinforce with pictures” 
option is on, a picture and a word beginning with the chosen letter is also shown at the 
bottom of the screen.  If a wrong answer is given, the answer is shown on screen, the student 
is corrected and given another chance to answer.  After a specified number of wrong answers 
is given (see Program Control - Rate of Advancement), the student is shown the correct 
answer and allowed to try again.

Letter Match can be set to use any set of letters from A to Z.  For instance, you can practice A 
through C today and D through F tomorrow, or you can practice hard to distinguish letters 
like b, d, p and q.  The default is A through Z.

Levels of Difficulty

Level  1 The student is asked to find the letter displayed on the screen.  The 
student finds the matching letter.

 2 The student is asked to find the specified letter from a selection of two 
letters.

 3 The student is asked to find the specified letter from a selection of 
three letters.

Letter Match

Level 1

Level 2 - after answer

Level 3
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 4 The student is asked to find the specified letter from a selection of four 
letters.

 

 

 5 Same as level 4 with the problems appearing in a random order, rather 
than alphabetically as on the other levels.

Choosing the Letters

To select a different series of letters, select “Choose Letters...” (Mac ⌘-K, Win Ctrl-K) from 
the Activity menu.  A dialog box like this one will appear:

Check the box next to each letter you 
would like the program to use for the 
lesson.  Click the “All on” or “All off” 
buttons to check or uncheck all letters.

The “Say” buttons determine whether 
the letter “Z” will be pronounced “zee” 
(American) or “zed” (British).

You can specify lowercase letters by 
clicking in the lowercase letters box.  If 
the box is off, uppercase letters will be 
used.

When the “Reinforce with pictures” 
item is checked, the program will 
display a picture beginning with the chosen letter whenever the student answers correctly.

Level 4 - lowercase letters

Level 5 - after answer
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Input Methods
Early Learning I supports a variety of input methods, allowing the teacher to fill each 
student’s individual needs.  You can control the input method by using the Input Options 
and Scanning Options dialogs.

Early Learning I has two basic modes of operation, called “Standard” and “Yes/No”.  In 
standard mode, the program accepts input from the keyboard or mouse, or from most other 
input devices, such as the TouchWindow or the IntelliKeys extended keyboard.

In “Yes/No” mode, the program presents problems in a way that the student can answer 
“yes” or “no”.  The student can answer by using a single switch, or by using one switch for 
“yes” and one for “no”.  The program scans all the possible answers, waiting for the student 
to answer “yes” or “no”.

Input Devices
This section describes the input devices supported by Early Learning I and how to use them.

Keyboard

The standard keyboard or any alternative keyboard like the BigKeys can be used in either 
standard or yes/no mode.  In standard mode, the student types the answer on the keyboard.  
In yes/no mode, the student presses the spacebar to answer “yes”.  When doing dual-switch 
scanning, the student can also press “y” to answer “yes” and “n” for “no”.

Mouse

In standard mode, the student just clicks the mouse on the answer to select it.  In some cases, 
the program needs a numeric input from the student.  In those cases, a number line is drawn 
at the bottom of the screen.  The student enters numbers by clicking on them in the number 
line.

In yes/no mode, the student just clicks the mouse to answer “yes”.  There’s no way to answer 
“no” with the mouse, so step scanning should not be used for mouse input, since it requires 
two switches (see Input Methods - Scanning Options).

TouchWindow

When using a TouchWindow, it works exactly like the mouse, as described above.  The 
TouchWindow can be used for either standard or yes/no input.
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IntelliKeys

The IntelliKeys keyboard can be used in either standard or yes/no mode.  Overlay files for 
use with Early Learning I are provided in the IntelliKeys Overlays folder inside the Marblesoft 
folder.  The Yes No Overlay is for use in yes/no mode.  The other overlays are for use in the 
standard keyboard mode.

To use the IntelliKeys, you must first print the overlay using the Overlay Printer program 
that came with your IntelliKeys.  Then load it into the IntelliKeys keyboard using Overlay 
Sender.  Finally, run Early Learning I and select the appropriate input mode.

All overlay files are set up for single switch access through the two ports on the left side of 
the IntelliKeys keyboard.  Connect the “yes” switch to Input 1, and the optional “no” switch 
to Input 2.  This way, you can run any activity in either standard or yes/no mode without 
ever having to change overlays.

Switches

Early Learning I works with any number of single-switch devices.  These are connected in a 
number of ways.  Typically, you will attach them by plugging them into another device like 
an IntelliKeys keyboard or a switch-adapted mouse, or into a dedicated interface device like 
the Don Johnston Switch Interface.

You can either use a single switch or two switches with Early Learning I.  With a single switch, 
the student answers “yes” and waits for the program to answer “no”.  With two switches, the 
student answers both “yes” and “no”.

Hook the first switch up to the computer so that it sends a “y” or “1” key, a space character, 
or a mouse click.  For dual-switch input, hook up the second switch so that it sends an “n” or 
a “2”.

If you are connecting the switches through the switch inputs on the IntelliKeys keyboard, 
load the “Yes No” overlay, which is pre-programmed to send a “y” from switch 1 and an “n” 
from switch 2.
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Input Options
To set the input options, select “Input Options...” from the Options menu (Mac ⌘-I, Win 
Ctrl-I).  A dialog like this one (Mac OS X version shown here) will appear.

Input Mode

Use these radio buttons to select either standard or yes/no 
mode.  You can also open the Scanning Options dialog 
directly from here (see Input Methods - Scanning Options).

Number Line

There are two ways to display the number line that is used 
in Counting Numbers for mouse and TouchWindow users:  
0 through 9 (like they really are) and 1 through 0 (like on a 
keyboard).  Click on the radio button to select which method 
you prefer.

 

Mouse Dwell

Mouse dwell is a feature for users who can use a mouse or other pointer device, but cannot 
click the mouse button.  When mouse dwell is on and the mouse is positioned over a 
clickable item, a countdown starts for the number of seconds specified.  When the countdown 
reaches 0, the mouse button is automatically clicked.

If the student moves the mouse during the countdown, the countdown stops.  If the mouse is 
stopped again on a clickable item, the countdown starts over.

To click the mouse twice on the same item, like when trying to enter 55 cents using the 
number line, position the mouse on the “5” key.  After the countdown reaches 0, the first 5 
will be entered.  Move the mouse slightly and pause again for the second countdown.
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Scanning Options
The Scanning Options dialog controls how Early Learning I scans the screen for single- and 
dual-switch users.  To set the scanning options, select “Scanning Options...” from the Options 
menu (Mac ⌘-Y, Win Ctrl-Y).  You will be presented with a dialog box looking like the one 
shown here (Mac OS 9 version shown).

The scanning options are described below:

Scanning On

Turning on the “Scanning On” check box is identical to selecting 
“Yes/No mode” from the Input Options dialog.  When turned 
on, the program will ask questions which the student can 
answer “Yes” or “No”.

Single- and dual- switch users both may respond “Yes” in a 
number of ways:

• The “Y” key or spacebar
• The “Y” or “space” switch on an IntelliKeys standard overlay
• The “Yes” switch on an IntelliKeys or Ke:nx On:Board custom overlay
• Clicking the mouse or trackball
• Pressing the TouchWindow or one of its buttons (depending on which mode you 

have selected in the TouchWindow Control Panel)

The student responds “No” by:
 

• Pressing the “N” key or “No” switch on the input device (dual-switch users only)
• Waiting until the scan time is elapsed and the program moves on (except when step 

scanning)

Scan Rate

The scan rate is the number of seconds that the program flashes each item before scanning 
to the next item in sequential or random scanning.  The lower the number, the faster the 
program scans.

When using two switches, the scan rate can be set to 99 so that the program doesn’t actually 
scan.  Instead, the student must press the “no” switch to cause the program to change to the 
next item.

The scan rate has no effect on step scanning.
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Scanning Order

Early Learning I provides 3 types of scanning.  Use the scanning order radio buttons to select 
the type of scanning most appropriate for your students.

Sequential Scanning

When sequential scanning is on, the program always scans in order from left to right, top to 
bottom or smallest to largest.  This gives the student advantage of anticipating what the next 
item will be, allowing the scan rate to be set a little lower (faster) because the student doesn’t 
need to rethink the problem after every scan.  In addition, dual-switch users can more quickly 
respond “no” using this method of scanning.

Random Scanning 

In random scanning, the program scans randomly among the items on the screen.  Some 
students will find this method more interesting.  When random scanning, the program scans 
to the “correct” item often enough that the student will not become frustrated.

Step Scanning

Step scanning is sequential scanning with one little difference.  When step scanning, the scan 
rate is ignored and the student must use a second switch to answer “no”.  The program will 
scan each item until the student answers either “yes” or “no”.

Starting Method

Use the “Start” buttons to select the scanning start method.  Start “Immediately” means that 
the program will begin scanning automatically as soon as the problem is displayed.  

When the start “On cue” button is on, the program will present the problem, then wait until 
the student presses a switch before scanning.  While the program is waiting for the cue, it 
flashes an image like this one to signal that it is waiting:

Use on cue scanning to give the student unlimited time to 
solve the problem without being distracted by scanning 
objects on screen.

Either starting method works with any of the three 
scanning orders.
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Prompting and Reinforcement
Early Learning I allows the teacher to custom-tailor the prompts and reinforcement that the 
program provides to best suit each student’s needs.  

Speech
Digitized speech is the key to Marblesoft’s success in helping the student to understand the 
problem that is presented and why an answer is correct or incorrect.  Much care has been 
taken to making the speech clear, informative and easy to understand.

There are four levels of speech from which to choose.  To set the speech level, choose a level 
from the Speech submenu under the Options menu.

The four levels of speech are described here:

Sassy

Sassy speech provides all the prompting and reinforcing speech of verbose (described below), 
but does it in a much more playful way.  You might not like this for certain students, but for 
others it adds a dimension of fun.  There are even a few playful insults that your students 
will find amusing, at least.  Enjoy!

Verbose

The default speech level is called “verbose”.  Verbose speech prompts the student for an 
answer, corrects mistakes and rewards correct answers.  When verbose speech is on, the 
student is prompted again if an extended period of time passes without a response or if a 
second attempt at a problem is needed.

Brief

Brief speech is limited to the minimum prompting that the student needs to solve a problem.  
This option is useful when a student is using Early Learning I in a setting where too much 
speech may be distracting to other students.

Off

When speech is off, audible tones are used to prompt, correct and reward the student.  These 
tones are consistent among all activities so their purpose is easily understood by the student.
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Sound Effects
Early Learning I uses sound effects to prompt, correct and reward the student.  Some sound 
effects are only played when speech is set to “off”.  Others can be turned on or off by the 
teacher.   Turn sound effects options on an off by using the Sound Effects menu under the 
Options menu.  The sound effect options are described here:

All Effects

When all effects are turned on, Early Learning I plays sounds to prompt, correct and reward 
the student.

Limited

When sound effects are limited, the program plays only the sound effects that are needed to 
prompt the student for a response, and to identify whether an answer is right or wrong.

Off

When sound effects are off, Early Learning I makes no sounds other than speech.

Click on Keypress

Selecting this option causes a slight “click” sound to be played whenever the student presses 
a key or switch on an input device.

Reward Sound

At the bottom of the Sound Effects menu is a list of sounds from which you can choose the 
sound that is played after a correct answer.  When you select a sound, it then becomes the 
“reward” sound for the next problem.
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Don’t Say “No”
When “Don’t say ‘No’” is checked on the Options menu, Early Learning I does not say the 
word “no” or play the “wrong” sound after a wrong answer.  Instead, the program just 
displays the answer as usual and prompts the student to try again.  

When the check mark is off, the program will say “no” or play the “wrong” sound depending 
on the current speech and sound effect levels.

To change the “Don’t say ‘No’” option, just select it from the Options menu to toggle it on or 
off.

Show Written Prompts
Early Learning I shows special written prompts on screen when the speech is turned off, so 
the teacher can prompt the student for the answer.  Checking the “Show Written Prompts” 
menu item will cause the written prompts to be shown even when speech is turned on.  This 
makes it easy for the teacher in a busy classroom to immediately see what problem a student 
is trying to solve.

Blind Prompts
Vision impaired students can use Early Learning I for some activities without any problem.  
However, other activities need to be modified a little so that vision impaired students can do 
them.

Counting Numbers requires the student to count the 
items on the screen.  For the vision impaired student, 
the Early Learning I can play special prompt tones 
as the objects are drawn on the screen.  In addition, 
some of the verbal clues in the other activities are 
changed for the blind student.

To turn on the blind prompts, select “Blind 
Prompts...” from the Options menu.  A dialog box 
will appear allowing you to specify a speed from 1 to 
10 (1 being the fastest):

When blind prompts are on, the student listens to 
count the objects as they are drawn on the screen at 
the specified speed.  Pressing the TAB key causes the 
prompts to be repeated.

Repeat Prompts Delay
You can specify the amount of time that Early Learning I waits for an answer before 
prompting the student again.  To do so, pull down the Options menu and select a delay from 
the “Repeat Prompts every” submenu.  The check mark indicates the current delay setting.  
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Early Learning I can be made to display either a small rocket ship or a hot air balloon 
in the lower right corner of the screen.  To turn on this option, pull down the 
Options menu and select either the rocket or the balloon from the Reinforcement 
menu.

The launch pad shows the number of correct answers needed in order to reach the 
next level (see Program Control - Rate of Advancement).  

As the student answers problems correctly, the launch pad counts down.  If a wrong 
answer is given, the countdown starts over.  

When the countdown reaches 0, the ship is full of fuel and takes off.  The program 
then advances to the next level.

Reinforcement
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Program Control
The following sections describe some other options that control the way that Early Learning I 
functions.

Ignore Some Responses
In some cases, you may want the program to ignore certain responses from the student, and, 
of course, Marblesoft provides a way for you to do it!

To ignore some responses, use the Ignore submenu in the Options menu.  The three options 
are described here:

Ignore Wrong Responses

When this item is checked, the program will ignore all wrong answers.  Using this option, 
only correct answers will be responded to or recorded in the student scores.

Ignore “Stray” Responses

The default behavior is for the program to ignore any responses outside a certain range.  
For instance, when using Counting Numbers, a stray response would be pressing a letter 
key.  This option should be used for the student who is easily distracted by the computer’s 
negative responses or the student with limited motor control who has trouble physically 
pressing the right key or switch.

Ignore None

You can also have Early Learning I acknowledge all responses.  Typically, the word “No” or a 
sound effect is played after a wrong answer (see Prompting and Reinforcement - Don’t say 
“No”), and the key that was pressed is shown on the screen.  The student is then prompted to 
try again.
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Rate of Advancement
Early Learning I automatically sets the level of difficulty according to the student’s scores and 
the parameters set by the teacher.  There are four settings which determine when the program 
will advance or go back a level, and when the student is shown the correct answer.

To change one of these settings, choose “Rate of Advancement...” from the Options menu 
(Mac ⌘-R, Win Ctrl-R).  A dialog box like this one will appear (Mac version shown here):

The function of the settings are described in the following 
paragraphs.

Advance Rate

This is the rate at which the student will advance to a higher 
level.  If the student answers this many consecutive problems 
correct without an error, the program will automatically switch 
to the next higher level.

Backup Rate

The backup rate is how many wrong answers the program will accept before sending the 
student back to the next lowest level.

Show Answer After __ Tries

This is the number of wrong answers that you want Early Learning I to accept before showing 
the student the correct answer.  When this number is reached, the student is shown the 
correct answer, then prompted to try again with the same problem.
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Fonts
You can select a font from the Font submenu in the Options menu.  That font will then be 
used for the text that the student sees on screen.  

Why would you want to do such a thing?  Well, for instance, you might want to choose Arial 
or Helvetica because they look the most like the keyboard.  Or, you might choose Times or 
Bookman because the characters look like the text in a child’s book.

You can choose a script font when a child is ready to learn cursive letters, or perhaps choose a 
whimsical font just for fun.  You could also use a font-making utility to create a font from the 
student’s own handwriting!

Full Screen Mode
You can hide the menu bar by choosing “Full Screen Mode” from the Options Menu (Mac 
⌘-F, Win Ctrl-F).  The program will hide the menu bar and use as much of the screen as 
possible to make the largest possible image for the student to see.

While in full screen mode, menu shortcuts (Mac ⌘-, Win Ctrl-) still work.  To use a menu 
item that does not have a shortcut, you’ll need to exit full screen mode by typing (Mac ⌘-F, 
Win Ctrl-F) again.

Use Stop Sign
You can allow keyboard users to return to the main menu and select another 
activity by choosing “Use Stop Sign” from the Options menu.  When this 
option is on, a small stop sign icon will be drawn in the lower left corner of 
the screen.  When the stop sign is on, the student can exit the current activity 
by clicking on the stop sign or pressing the “Esc” key.

“Use Stop Sign” has no effect when the program is in yes/no mode.  When in yes/no mode, 
use the “Close Activity” command described below.
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Some of the program’s colors can be changed to make the problems easier to see for your 
low-vision students.  To customize a color of an item, choose the item from the Customize 
Colors menu.  A color picker like this one will appear (Mac version shown):

Select the new color you would 
like to use and press “OK”.

Following is a description of the 
colors you can customize.

Screen Backgrounds

The screen background is the solid 
color used as the background for 
the problems.  The program uses 
light pastel colors as defaults. 
Each activity has its own background color.  You can only change the background color for 
the current activity.

Warning:  Most text and prompting is black and cannot be changed.  If you make the background too 
dark, it will be hard for the student to see the text.

Number Line Numbers

This is the color for the numbers that are printed on the number line at 
the bottom of the screen for mouse and TouchWindow users on Counting 
Numbers.  You can only set this option from Counting Numbers.

Number Line Keys

This is the background color for the number line at the bottom of the screen for mouse and 
TouchWindow users on Counting Numbers.  You can only set this option from Counting 
Numbers.

Close Activity
To exit the current activity, select “Close xxx” from the File menu (Mac ⌘-W, Win Ctrl-W) 
where xxx is the name of the activity.  The program will return to the main menu, where you 
can select a different activity.

You can also jump directly to any activity by using the following keyboard short cuts:

Mac  Win Activity
⌘-1 Ctrl-1 Matching Colors
⌘-2 Ctrl-2 Learning Shapes
⌘-3 Ctrl-3 Counting Numbers
⌘-4 Ctrl-4 Letter Match

Customize Colors



35

Pause
Early Learning I prompts the student for a response every few seconds if the student has not 
yet answered (see Prompting and Reinforcement - Repeat Prompts Delay).  In Yes/No 
mode, the program also repeats the “Yes/No” question each time it scans to a different item.  

You can temporarily turn off these prompts by selecting “Pause” from the Activity Menu 
or typing (Mac ⌘-P, Win Ctrl-P) from the keyboard.  While in pause mode, Early Learning I 
continues to display the problem, but does not prompt the student again until an answer is 
given.

Use the pause mode to give the student an unlimited amount of time or when the  program is 
sitting unattended and you just want it to BE QUIET!

Quit
To quit Early Learning I:

Macintosh

Select “Quit” from the File menu or type ⌘-Q.

Windows

Type Ctrl-Q, or use the Windows-standard Alt+F4.  When not in full screen mode, you can 
also choose “Exit” from the File menu or type Alt+F/X.



36

Student Scores
Early Learning I contains a built-in system for tracking and reporting a student’s progress.  
The program is designed to work in conjunction with all of the programs in Marblesoft’s 
Early Learning series.  To take advantage of this feature, you should save the student files in 
a folder named “Student Scores” that is located inside the same folder as the Early Learning 
programs.  Early Learning I will automatically create this folder the first time you run it.

The following sections describe student files and how to create, modify, record and report 
them.

New Student File
Before recording any scores for a student, you must create a 
student file.  Select “New Student File...” from the File menu or 
type (Mac ⌘-N, Win Ctrl-N).  When the dialog appears (Mac 
version shown), type the student’s name. 

When you click the “OK” button a dialog box like this one will 
appear to ask you for a file name:

Early Learning I suggests a file name for 
the student file based on the name you 
entered.  You can make the file name 
anything you want, although you would 
typically use the student’s name.  

When you are satisfied with the file name 
and the location, click on “Save” to save it 
to disk.

The program will create a new student file 
using the formatting preference you have 
specified (see Preferences).  There is no way to change the formatting of a student file after 
you create it.  To use the alternate formatting style, you’ll need to change the preference in the 
Preferences dialog, then create a new student file.
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To begin recording scores to a student’s file, choose “Open 
Student File...” from the File menu or type (Mac ⌘-O, Win 
Ctrl-O).  A dialog box will prompt you to select the student file 
you want (Mac version shown here):

Locate the student file and click on “Open”.  The program will 
open the file and automatically begin recording the scores for 
that student.  They will be recorded until the file is closed or 
until another student file is opened.

Save Student Scores
When the student is finished with Early Learning I, select “Save Student Scores” from the File 
menu or type (Mac ⌘-S, Win Ctrl-S).  The scores will be added to the student’s file.

When a student’s scores are saved, Early Learning I also saves all the current program settings.  
These settings are then used by all Early Learning programs (version 2.1 or later).  For 
instance, if you turn scanning on and save a student file, scanning will be on the next time 
you open that student’s file in Early Learning I or any other Early Learning program.

Along with the program settings, Early Learning I saves the current activity and difficulty 
level for the student, so it can be restored when the student’s file is next opened.

You should only save the scores at the end of a session.  Early Learning I records the scores a 
full session at a time.  If you save the scores in mid-session and again at the end, the program 
treats them as two separate sessions, making the records longer and less easy to read.

If you forget to save the scores, the program will remind you before you open another 
student file or quit.

Close Student File
To stop recording a student’s scores, select “Close Student File” from the File menu.  If there 
are any unsaved records, you will be prompted to save them before the file is closed.

Open Student File
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Reviewing Student Files
Early Learning student scores are saved in text files that can easily be opened, edited and 
printed using any typical text editor or word processor.  How you will prepare your student 
files for printing depends on the formatting option you had set in your preferences dialog 
(see Preferences) when you created the student file.

Using a word processor or spreadsheet program, you can easily create a report showing a 
single student’s progress over time, or perhaps a comparison or summary of several students.  
We’ll leave the creativity up to you.  This section describes only how to format the student 
score data.

When you open or import a student file into a word processor, it will begin with a header 
something like this:

Early Learning Student Scores

Student:  Kristi Johnson
File created 11/8/03

Format:  Tab delimited 
(or, in the case of a monospaced file...)
Format:  Monospaced

Open this file in a word processor or spreadsheet program to see the columns 
formatted correctly.

Do not modify the first six lines of this file, or the Early Learning programs may 
not be able to read it.  If you want to make changes above the dotted line, 
duplicate the file and make your changes to the copy.

----------

The first six lines cannot be modified if you wish to record any more scores to the same file.  
The preferred method is to save the file with a different name, then modify the copy.  Once 
you’ve created an editable copy, you can modify it as described on the next few pages.

The first two paragraphs show the report title, the student’s name and the date the file was 
created.  Modify these lines as you wish.

The third paragraph, beginning with “Format:” and the fourth paragraph, beginning with 
“Do not modify” are informational only, and can be deleted.

The dotted line signifies the end of the header and the beginning of the student scores.  The 
scores will be formatted differently depending on the formatting method set when the file 
was created.  The two formatting methods are described below.
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This is the default format an is the easiest to create professional-looking reports.  You can edit 
and print tab-delimited scores using any text editor, but usually you would use either a word 
processor or a spreadsheet program.

A word processor allows you to quickly format and print great looking reports.  Editing the 
scores in a spreadsheet gives you powerful formatting options plus the ability to create your 
own summary and statistical reports based on the student scores.

Both methods are described here:

Word Processor

When you open or import a student file into a word processor, the scores will usually look 
something like this:

Date:  11/8/03
Matching Colors Attempts Right Wrong Stray No Err %No Err
  Level 1 13 13 1 0 12 92
  Level 2 17 17 2 0 15 88
  Level 3 7 6 3 2 3 43

----------

Date:  11/11/03
Matching Colors Attempts Right Wrong Stray No Err %No Err
  Level 3 7 7 0 0 7 100
Learning Shapes Attempts Right Wrong Stray No Err %No Err
  Level 1 12 11 4 1 9 75

Not bad, except the columns don’t line up.  That’s because most word processors just put left-
justified tabs every half an inch unless you specify otherwise.

What we need to do is add some right-justified tabs.  We’ll add the first one at 2.25”, then 
every .625” after that.  The tab ruler in our word processor will look something like this (this 
one’s from Adobe InDesign):

That’s all there is to it!  Removing the unnecessary information in the header, a brief note and 
a font change gives us a report that looks like the one on the next page.

Tab-Delimited
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Dear Principal Hawkins:

Here is the information on Kristi Johnson you requested.

Early Learning Student Scores

Student:  Kristi Johnson
File created 11/8/03

----------

Date:  11/8/03
Matching Colors Attempts Right Wrong Stray No Err %No Err
  Level 1 13 13 1 0 12 92
  Level 2 17 17 2 0 15 88
  Level 3 7 6 3 2 3 43

----------

Date:  11/11/03
Matching Colors Attempts Right Wrong Stray No Err %No Err
  Level 3 7 7 0 0 7 100
Learning Shapes Attempts Right Wrong Stray No Err %No Err
  Level 1 12 11 4 1 9 75

Ms. Jones
2nd Grade

Spreadsheet

When you want to import student data into a spreadsheet program for statistical 
summary and analysis, create the student files with the “tab-delimited” preference set (see 
Preferences).  If you try to import monospaced data into a spreadsheet, it will all be placed 
into a single column.

To import student scores into a spreadsheet, depending on your spreadsheet program, 
you can open it directly, import it to an already open spreadsheet, or copy it from a word 
processor and paste it into the spreadsheet.

After importing the data into your spreadsheet, it looks something like this:
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That’s not too bad.  We need to increase the width of column A a little and narrow columns 
B - G.  It would be a good idea to right-justify columns B - G also.

Here’s what our spreadsheet looks like with the above changes and a row of column totals at 
the bottom:

There it is, ready for your headings and commentary.
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Monospaced
The alternate format for student score files is the “monospaced” format.  This is useful when 
you don’t have complete control over the formatting of text and the setting of tabs, such as 
when sending e-mail or formatting Web pages (without using tables).

When you import a monospaced student score file into a word processor, the score data 
usually looks something like this:

  

Date:  11/8/03
Matching Colors       Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 1                   13     13      1      0      12       92
  Level 2                   17     17      2      0      15       88
  Level 3                    7      6      3      2       3       43

----------

Date:  11/11/03
Matching Colors       Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 3                    7      7      0      0       7      100
Learning Shapes       Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 1                   12     11      4      1       9       75

Instead of tabs separating the columns, a monospaced contains the correct number of spaces 
between columns to line them up correctly when using a monospaced font, such as Courier.  
Monospaced fonts are fonts where every character is the exact same width, so it’s easy to 
predict how much space they will take on the page.

When formatting student scores for a Web page, use the <pre> tag around the text you want 
monospaced.  Here’s an example of some monospaced student scores formatted for HTML.  
The example is shown in Courier font.  (The <pre> and <\pre> tags are hidden by the 
browser so they won’t show on the finished Web page.)

<pre>
Date:  11/8/03
Matching Colors       Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 1                   13     13      1      0      12       92
  Level 2                   17     17      2      0      15       88
  Level 3                    7      6      3      2       3       43

----------

Date:  11/11/03
Matching Colors       Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 3                    7      7      0      0       7      100
Learning Shapes       Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 1                   12     11      4      1       9       75
</pre>

There it is, ready to e-mail or publish on the Web.
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Preferences
Early Learning I remembers most program settings when you quit the application.  All settings 
such as the currency you’re using, activity settings, input and reinforcement options and 
scanning settings are saved when you quit and restored exactly as you left them the next time 
you run the program.

There are a couple of preferences that you set from the Preferences dialog.  To set them, select 
“Preferences...” from the Edit menu.  A dialog something like this one will appear (Mac 
version shown here):

When the “Load student at startup” box is checked, the 
program will bring up the “Open Student File” dialog 
automatically every time you run the program.

The “Save student scores” buttons set which type of student 
score files will be created.  Existing student score files are not 
affected by this setting, only student files created after the 
preference is changed.
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Keyboard Shortcuts
These are some useful keyboard shortcuts in Early Learning I:

Mac Windows Action
⌘-1 Ctrl-1 Matching Colors
⌘-2 Ctrl-2 Learning Shapes
⌘-3 Ctrl-3 Counting Numbers
⌘-4 Ctrl-4 Letter Match
⌘-W Ctrl-W Close Activity and return to main menu (You can also use 

ESC if the “Use Stop Sign” option is on)

⌘-Q Ctrl-Q Quit (Windows users can also use the Windows-standard 
Alt+F4.  When not in full screen mode, you can also choose 
“Exit” from the File menu or type Alt+F/X.)

⌘-A Ctrl-A Advance a level
⌘-B Ctrl-B Back a level
⌘-L Ctrl-L Go to level
⌘-P Ctrl-P Pause

⌘-F Ctrl-F Full screen mode (or back to menu mode)
⌘-K Ctrl-K Choose colors, shapes, numbers, letters and activity options
⌘-I Ctrl-I Input options
⌘-Y Ctrl-Y Scanning options
⌘-R Ctrl-R Set rate of advancement, etc.

⌘-N Ctrl-N Create new student scores file
⌘-O Ctrl-O Open existing student scores file
⌘-S Ctrl-S Save student scores

TAB TAB Repeat the last prompt (useful when blind prompts are on)
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Technical Support
If you are having trouble with Early Learning I or need help understanding some of the 
program’s features, feel free to take advantage of our free technical support.

Mail

Marblesoft Technical Support
12301 Central Ave NE 
Suite 205
Blaine, MN  55434

Phone

(763) 502-0440

If you call, please leave numbers where you can be reached both during and after normal 
business hours.  Don’t forget to leave your area code!

Fax

(763) 862-2920

E-mail

support@marblesoft.com

World Wide Web

www.marblesoft.com

Early Learning I has evolved for more almost two decades into the program it is today.  A big 
part of that evolution has been the suggestions from teachers and parents on how to make 
improvements to the program.  Please continue to make those suggestions so that Early 
Learning I keeps getting better!




